relen: A COMPOSITION FOR ALTO SAXOPHONE, DOUBLE BASS, TWO PERCUSSION, AND INTERACTIVE ELECTRONICS

Benjamin David Johansen, B.M.E., M.M.

Dissertation Prepared for the Degree of

DOCTOR OF PHILOSOPHY

UNIVERSITY OF NORTH TEXAS

May 2012

APPROVED:

Jon Nelson, Major Professor
David Bithell, Committee Member
David Stout, Committee Member
Joseph Klein, Chair of the Division of Composition Studies
Lynn Eustis, Director of Graduate Studies in the College of Music
James Scott, Dean of the College of Music
James D. Meernik, Acting Dean of the Toulouse Graduate School
Johansen, Benjamin David. *relent*: A composition for alto saxophone, double bass, two percussion, and interactive electronics. Doctor of Philosophy (Composition), May 2012, 72 pp., 1 table, 16 figures, reference list, 41 titles.

*relent* is a sacred work within the genre of interactive electronic music. The 20-minute composition is a multi-movement piece for four instrumentalists (saxophone, double bass, and two percussion) and computer that is inspired by the gospel message. *relent* is specifically about the gospel message that Christ died for man’s sins, rose from the dead, and through faith in him man can be reconciled to God.

This project was an experiment in creating a work with a programmatic extramusical structure. In preparation for writing a piece based on Christian programmatic content, this paper presents an overview of research conducted on the intersection between art and Christianity referencing authors such as Harold Best, Nikolai Berdyaev, Hans Rookmaaker, Calvin Seerveld, Daniel Seidell, A. W. Tozer, Steve Turner, and Cornelius Van Til. This work was an experiment in trying to make very direct and specific musical ties to the narrative of the Gospel.

Another highly experimental aspect of *relent* was in the way interactive electronics were used. Each acoustic instrument in the work has its own input and module within the Max patch, extending each acoustic instrument rather than adding an electronic accompaniment component. Additionally, non-traditional notation, both codified and real-time computer generated, improvisation, theatrical instructions, and a completely computer generated movement makes *relent* a piece that challenges and pushes the boundaries of current interactive electronic music.
ACKNOWLEDGEMENTS

This dissertation would not have been possible with the dedicated compositional guidance of Dr. Cindy McTee, Dr. David Bithell, David Stout, and Dr. Jon Nelson. Dr. Joseph Klein’s support, in assisting with scholarships, fellowships, and other academic opportunities throughout my doctoral education is also especially appreciated. Dr. Andrew May’s insisting of modular construction of interactive computer programs was key to the success of relent. I also want to thank Adam Lancaster and Michael Jarrett for their theological insight.
TABLE OF CONTENTS

ACKNOWLEDGEMENTS .................................................................................................................. iii

LIST OF TABLES ............................................................................................................................. v

LIST OF FIGURES .......................................................................................................................... vi

PART I: CRITICAL ANALYSIS

Chapter 1: Introduction .................................................................................................................... 1
Chapter 2: Towards an Understanding of A Christian’s Art............................................................. 7
Chapter 3: Interactive Computer Technology ................................................................................. 17
Chapter 4: Analysis of relentless

  Movement I: realized (Creation).................................................................................................... 32
  Movement II: rejected (Fall of Man)............................................................................................ 38
  Movement III: redeemed (Redemption)....................................................................................... 42
  Movement IV: reconciled (Justification/Sanctification)............................................................... 43
  Movement V: reside (Reconciliation)......................................................................................... 46
Chapter 5: Conclusion ..................................................................................................................... 49
Reference List ............................................................................................................................... 51

PART II: relentless

Movement I: realized ..................................................................................................................... 58
Movement II: rejected .................................................................................................................. 62
Movement III: redeemed .............................................................................................................. 66
Movement IV: reconciled ............................................................................................................. 67
Movement V: reside ..................................................................................................................... 68
1. Table 1. An overview of the variety constructed into *relent*. .................................................................33
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The performance mode of the Max patch used for <em>relent</em></td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>Schematic for pedals</td>
<td>22</td>
</tr>
<tr>
<td>3</td>
<td>The pan and reverb user interface modules in <em>relent</em>’s patch</td>
<td>25</td>
</tr>
<tr>
<td>4</td>
<td>Hold and freeze, harmonizer, vocoder, and granulator, and flange modules</td>
<td>27</td>
</tr>
<tr>
<td>5</td>
<td>Recpb (record play backwards) abstraction</td>
<td>28</td>
</tr>
<tr>
<td>6</td>
<td>Looper abstraction</td>
<td>29</td>
</tr>
<tr>
<td>7</td>
<td>User interface for looper modules</td>
<td>30</td>
</tr>
<tr>
<td>8</td>
<td>Beginning of movement I, “realized,” of <em>relent</em></td>
<td>35</td>
</tr>
<tr>
<td>9</td>
<td>Ascending marimba harmonies</td>
<td>36</td>
</tr>
<tr>
<td>10</td>
<td>Double bass reduction from rehearsal mark 4 for nearly 7</td>
<td>37</td>
</tr>
<tr>
<td>11</td>
<td>Excerpt from the first page of movement II, “rejected.”</td>
<td>39</td>
</tr>
<tr>
<td>12</td>
<td>The abstraction that records each gesture in movement II</td>
<td>41</td>
</tr>
<tr>
<td>13</td>
<td>Computer generated score for movement IV of <em>relent</em></td>
<td>44</td>
</tr>
<tr>
<td>14</td>
<td>An abstractions used to choose and display text in movement IV</td>
<td>45</td>
</tr>
<tr>
<td>15</td>
<td>Simplified model of an excerpt from movement V</td>
<td>47</td>
</tr>
</tbody>
</table>
PART I

CRITICAL ANALYSIS OF relent
Chapter 1

Introduction

Inspiration for \textit{relent}

I have been a practicing Christian since I was very young. Because nothing in my life holds more importance to me than my faith, I thought it fitting to create a work of art inspired by my personal beliefs. I found it particularly challenging and rewarding to create a sacred work within the medium of my interest: interactive electronic music. The 20-minute composition I composed, entitled \textit{relent}, is a multi-movement piece for four instrumentalists (saxophone, double bass, and two percussion) and computer that is inspired by the gospel message. \textit{relent} is specifically about the gospel message that Christ died for man’s sins, rose from the dead, and through faith in him man can be reconciled to God. This paper examines the intersection between art and Christianity and provides insight into the technology and compositional processes within \textit{relent}.

A number of contemporary artists have been inspired by sacred topics. Henryk Gorecki (1933-2010) has set traditional liturgical text in a 20th-century fashion. In his \textit{Miserere Op. 44}, Gorecki set a very short text in a manner that emphasized his interpretation of the text. The first half of the short text, \textit{Domine Deus noster} (O Lord our God), is the sole text for over 30 minutes of the piece. As is common of Gorecki’s style, the piece begins with a monophonic line performed at a very quiet dynamic. Slowly, over a 30 minute period, more voices enter and the dynamics rise substantially as the original monophonic line evolves into a massive, thick, dissonant texture. This progression to a climactic display of vocal force enhances the power found in the name of the Lord. This eventually dies down dynamically and texturally as the next
short phrase, *miserere nobis* (have mercy on us), is quietly sung. It is my assumption that Gorecki set out to show the literally awesome existence of the Lord and respectful posture that should be offered the Creator when pleading for mercy.

Alan Hovhaness (1911-2000) was inspired by God’s creation when he wrote *And God Made Great Whales*. Hovhaness brought authentic recordings of whale sounds into his piece and accompanied them with a full orchestra. Olivier Messiaen (1908-1992) has also been inspired by God’s creation. Much of Messiaen’s music is influenced by visual color and bird songs. In *La Transfiguration de Notre Seigneur Jésus-Christ* (The Transfiguration of Our Lord Jesus Christ), Messiaen focuses his attention on the great light described in the story of Jesus’ transfiguration found in the Gospels of the Bible. Messiaen meticulously chose scripture to use in the piece to provide narrative as well as elucidate his own insight, much like Bach did in his creation of the Passions. The orchestral accompaniment contains over 100 birdsongs, well noted by the composer in the score. The massive work is set in Latin, which, similarly to Gorecki’s work, adds a mysterious element.¹

Arvo Pärt (b. 1935), though more commonly prone to use Latin text, set John 15:1-14 in English in his work *I am the true vine*. In the passage, Jesus describes the ideal relationship between humanity and God. Pärt uses a chant-like setting of the text to communicate his view of Jesus’s teaching in a peaceful manner characteristic of Jesus. Pärt’s use of *tintinnabuli*, quiet dynamics, thin textures, and slow, comfortable rhythms creates an image of intertwining vines.

John Tavener (b. 1944) and James MacMillan (b. 1959) are prolific composers inspired by biblical imagery and spiritual living. Tavener’s *Risen!* is fashioned with a twelve note row that

---

¹ Paul Griffiths, Liner Notes from *La Transfiguration*, Orchestra Philharmonique de Radio France, conducted by Myung-Whun Chung, Deustche Grammophon 471 569-2, 2001, CD.
creates the effect of a massive rising dominant seventh chord. In the piece, Tavener sought out to display the incredible joy that surrounds the imagery of Christ rising from the dead after atoning our sins. Written for Evelyn Glennie as a percussion concerto, *Veni, Veni, Emmanuel* (Come, Come, Emmanuel) displays MacMillan’s interests in programmatic sacred music. The powerfully, energetic, driving work is inspired by Advent. One of the most moving effects MacMillan created in the work is the use of what are unmistakably sounds of a heartbeat interspersed throughout the work. The heartbeat symbolizes the humanity aspect of Jesus, a concept that is especially important to understanding the full depth of the Advent season.

These works inspired my composing of *relent* and demanded, in my opinion, a better understanding of the relationship between art and Christianity. Without researching authors such as Harold Best, Nikolai Berdyaev, Hans Rookmaaker, Calvin Seerveld, Daniel Seidell, A. W. Tozer, Steve Turner, and Cornelius Van Til, *relent* would have been an entirely different piece. Composing *relent* represents my first effort in creating gospel centered art, and is influenced by my research to examine the difference between Christian art and art created by a Christian.

I decided to create a piece about the gospel message before executing any research about art and Christianity. My interest in the gospel message reflects current trends within Reformed theology, or Calvinism, to center all aspects of life and worship on the gospel message. Like anything else I come across that is extreme or truly demands awe (e.g., thinking about quantum physics, experiencing the aurora borealis, or surviving a plane crash), I was compelled to imagine how the beauty of the gospel message could be realized through art. In a discussion with

---

Kevin DeYoung and Ligon Duncan, Albert Mohler describes this recent, radical resurgence of Reformed theology beliefs and how, or why, it might be happening:

I think it comes from very deep wells ... you have new people in a new time who are rediscovering the same kind of theological instincts and impulses that led to the reformation, and finding them in the same sources, which is the scripture. ... The sovereignty of God is the beginning and end of this. That does not emerge from the kind of churched culture that many Americans knew, it emerges from young people trying to swim against the tide of secularism.³

Mohler goes on to suggest that there is a young generation of Christians, not raised in families that frequently attended church, questioning why it is they have been drawn to believe in Christianity and, more specifically, whether it was something they did or something God did. Mohler suggests that the answer being found is something deeply rooted in Reformed theology: the sovereignty of God.

I chose to research the Reformed theological view of the gospel message through a number of authors and preachers.⁴ Based on my research of the Bible and Reformed theological interpretations and commentary on the Bible, sermons, articles, websites (theresurgence.com, thevillagechurch.net, thegospelcoalition.org, and desiringgod.org), and position papers, I decided to frame the biblical narrative through five movements in the following way:

I. Creation of all things (Gen. 1-2)
II. The Fall of Man (Gen. 3)
III. Redemption of Man through Jesus’s death/resurrection (Rom. 1, 1 Cor. 15)
IV. Justification and Sanctification of Man (Eph. 2:13, Col. 2:13-15)
V. Eternity in Heaven Worshipping God (Rev. 21)

The narrative concept for these five movements allow for an especially compelling


⁴ Matt Chandler, Mark Driscoll, Gilbert Greg, Wayne Grudem, Charles Kraft, Tim Keller, C. J. Mahaney, J. I. Packer, A. W. Pink, John Piper, Tullian Tchividjian, JR Vassar, Albert M. Walters, and N. T. Wright (see bibliography for works by these authors and preachers researched in this paper).
musical structure with extreme contrasts and powerful connections. The gospel message contains stark contrasts, from the fall of humanity out of a perfect relationship with God to the redemption of humanity through Jesus’s death and resurrection. Art inspired by the gospel message allows for the manifestation of profound concepts such as God, sin, death, atonement, life, hope, and new beginnings. The seemingly paradoxical concepts of the Trinity, sin and redemption, capriciousness and steadfastness, love and discipline, and suffering and joy add yet another layer of complexity to the structure and sonic makeup of a work of art inspired by the gospel message.

This is the first time in my compositional career to attempt to create a work that is directly programatic. All of my pieces up until this point have been non-representational, abstract works with a focus on form and structure rather than on extramusical narratives. While relent is capable of standing alone, without any justification, explanation, or understanding of its inspiration (as do my previous works), a deeper understanding of the work will be provided through the following: a review of my research on art and Christianity, a feeling for my grasp of the work in history, my research on the gospel message, insights on relent’s technology, and an analysis of the piece.
Chapter 2
Towards an Understanding of A Christian’s Art

The idea of composing for acoustic instruments and interactive electronics on the topic of the gospel message was greatly influenced by theological research. Where previous assumptions and stereotypes on the subject set limitations on art and enabled mediocre creativity, research provided freedom and encouraged depth. This section of the paper attempts revealed one possible perspective of the difficulties and freedoms found in creating art from a Christian worldview.

The first difficulty faced in composing was feeling an obligation to contain all of the magnitude of the gospel message in a single work of art. Two illustrations provide understanding and relief from this burden. The first illustration is an analogy built upon a football game. The best seat, visibly, to a football game is in front of the television. Viewing a football game from a seat in the football stadium provides only one perspective of view. On the other hand, TV networks provide many different camera angles, each customized for specific plays in different locations of the field. An artist can imagine himself as having the ability to provide only one view of any subject, analogous to one of the many cameras of a TV network station. When an artist understands this, he is free to provide his one perspective rather than overwhelmed at trying to present every angle of a subject. The second illustration, an antidote about J.R.R. Tolkien, may better clarify this concept. Amidst a writer’s block, Tolkien wrote Leaf of Niggle, a fictitious short story. In summary, Niggle was an artist with the one ambition to paint a huge mural of a tree on the side of the town’s post office building. He spent all his life painting the mural and died having only painted one single leaf of the tree he envisioned. On a train to
Heaven, Niggle saw a tree and asked the train to stop. When he approached the tree he realized it was the tree he had spent his whole life trying to paint and had only completed painting one leaf. After writing the short story, having realized he would only ever produce “a single leaf,” Tolkien went on to write *The Lord of the Rings*. “He realized he would never produce the whole tree, the whole glory of God” and so he was free to create what he could. This concept allowed me to approach composing without the burden to addressing every aspect of the gospel message.

Another difficult issue in art and Christianity is the lack of understanding among evangelicals on form and content of art. Creating a piece of art for the sole reason of communicating a message can many times force the artist to oversimplify their art in such a way that it becomes bland and mediocre. Most works of art are not created to communicate messages such as announcements of gatherings and, unfortunately, many calling for such logistical messages to be communicated see no difference between well done design and well done art. When asked after a dance concert to explain what a dance meant, Isadora Duncan replied that if she could explain what it meant in words, she would not have had to dance it. The idea that art is a medium for communication of concise messages can often debase the potential depth of art, restrict its development, and strip it of its beauty and complexity. The following quote by Daniel Siedell better clarifies this concept:

> For most evangelical art writers, art follows the conventional sender-receiver model of communication, in which the form of the communication disappears in order for the content, the message, to be received clearly and without alteration from the sender. Evangelicalism tends to treat art as speech, or dogma, conducted by other means. And when its “message” is ambivalent, complex, and difficult, yielding different interpretations, it is considered suspect. As Pavel Florensky observes, “True art is a unity...

---

of content and the means of expressing that content.” Form, then, is as important as the content.

Art is not a visual illustration of a truth, idea, thought, or worldview already formulated, cloaked in aesthetic form, and then “sent” to the receiver. Truth, an idea, a thought, or even a worldview emerges through the relationship between the viewer and the work, which cannot be limited and defined by the intentions of the artist, even though the artist’s intentions (conscious or not) are the impetus of the work. Artists make art not because they have knowledge they want to “express” but because they want to discover or learn something through the practice of art. Communion and contemplation, then, are disciplines not merely for viewers but also for artists as they make their work.\(^6\)

Siedell’s main point is that it is a mistake to try to communicate concepts through art that already have clear means of communication for merely aesthetic reasons. Art is meant to express that which cannot be expressed any other way. To use art as simple communication is to miss out on depth and complexity.

According to Michael Card, an artist should be free to create whatever he envisions, so the work can become “fully itself,” instead of some forced, compromised piece fashioned to solely minister.\(^7\) The Calvinist view is that God is sovereign, wholly responsible for saving those he chooses, and that the Holy Spirit is necessary to facilitate salvation. Seerveld supports this idea when he explains that it is not the artists duty to convert or defend following Jesus, instead he is to create art that provides his perspective on the world and allows the Holy Spirit to work in the hearts of those that experience it.\(^8\) Thus, an artist is free to create without the burden of saving souls.


\(^{8}\) Ibid., 145.
Being freed from the necessity to proselytize through relent did not lift the concern of whether a Christian was required to present traditionally Christian programmatic content into his work. Steve Turner shows that this is a substantial issue:

One of the great hindrances to the development of biblically informed mainstream art has been the perception that Christians should make “Christian art” and that “Christian art” is always explicitly religious.9

The relieving truth is, one does not need to create art with blatantly Christian symbols and themes in order to be considered a Christian artist. The deeper issue at hand is where one’s heart is.

Another difficulty faced by many Christian artists is whether or not there are mediums they should not work within. A lack of understanding of theology leads many to believe that Christians should not work within specific mediums. The following quote provides the Reformed view of using the materials God has provided to the fullest:

And God blessed them; and God said to them, “Be fruitful and multiply, and fill the earth and subdue it, and rule over the fish of the sea and over the birds of the sky and over every living thing that moves on the earth.” (Genesis 1:28, NASB, emphasis added)

Reformed theologians take this passage as a command, a charge, to subdue not only all living creatures, but to discover and use the potentials in all materials, including their macro and micro structural dimensions. This enlarged scope appears justified from these words addressed to man elsewhere: “you put everything under his feet ” (Ps. 8:6); “God left nothing that is not subject to him” (Heb. 2:8). In uttering this mandate, God dignified mankind’s work, and “crowned him with glory and honor” (Ps. 8: 5).10

According to the Bible, humans have been commanded, by God, to experiment with all the materials God has created in order to not only understand how they work and glorify God for his creativeness, but to use them in new and creative ways than those immediately apparent. As


artists combine, bend, master, tame, reshape, develop, refashion, put into motion, slow down, speed up, freeze, multiply, and repurpose the many various and diverse materials God created, through hard work, practice, long hours, blood, sweat, tears, collaboration, investigation, research, wisdom, education, council and divine guidance, they find more ways to glorify, praise, understand, and walk with God, and in a way, “extend God’s creation.” Artists may be “finite ... bound by creation ... [unable] to step outside of it,” but artists are able to use their vision and unique perspective of God’s creation to find “cosmos in chaos,” as Leonard Bernstein explains.

C.S. Lewis, in The Great Divorce, provides a perspective of art through a fictitious story about an artist’s arrival in heaven. Once he arrives, the artist is so amazed with heaven’s beauty he longs for art supplies to paint. Through the character we realize that in heaven it is more important to simply see. Lewis cleverly points out that artists should point toward another world, not be confined to the standards of this world.

It was especially important to the creation of relentless to understand that there is no medium by which a Christian is confined. This research validated the experimental nature of relentless. Creating avant-garde, interactive electronic music falls directly under the command to subdue the earth (Genesis 1:28). Christian artist are given freedom by God through faith. To be a child of God’s means to be given freedom from sin, from death, from one’s self, from going through life in the dark, from having to prove one’s own worth, from fear of man, from anxiety about the

11 Ibid.
13 L’Engle, 8.
future or circumstances, and from all the other things that keep people from glorifying God and thinking about the gospel.

Freedom includes the right to choose your own style, to be free from tradition but also from modernity, from fashion, from today and tomorrow as well as from yesterday ... Christian freedom also is freedom from the sinful lust for money, from seeking man’s praise, from the search for celebrity. It is the freedom to help a neighbor out and give him something to delight in.\(^{15}\)

Creativity works at its best when people are given the freedom to work without the boundaries of legalism, burdens of traditionalism, and selfishness of egoism. It is fear of judgement by others that often force artists to be controlled by conventions and stereotypes.

With an understanding of artistic freedom, especially that any piece composed by a Christian could be completely abstract without any tie to specific Biblical stories or blatantly Christian concepts, the question arose as to how to deal subjects of evil. Seerveld states that rather than view sin in a violent, angry, powerful manner that lifts, enables, and exalts evil, Christian art should paint sin as sorrowful.\(^{16}\) This view of sin contradicts the use of aggressive and loud extended technique in the second movement of *relent*, a compositional choice that seems to be most effective within the structure of the entire work. Christians are instructed both to “Let love be genuine. Abhor what is evil; hold fast to what is good”\(^ {17}\) and to “Take no part in the unfruitful works of darkness, but instead to expose them.”\(^ {18}\) This being the case, it seems only right that a Christian should not elevate evil in such a way to make it appear praise worthy, but expose it in whatever view they withhold. Seerveld chooses to bring out the sorrowful nature


\(^{16}\) This concept greatly effected the composition of *relent*’s second movement inspired by The Fall where sin came into the world.

\(^{17}\) Romans 12:9 (ESV)

\(^{18}\) Ephesians 5:11 (ESV)
of sin while I choose, within the context of relent, to expose sin’s destructiveness. As long as evil is not praised, both of our artistic choices are justifiably correct.

It is easy to forget that no one is responsible for the talents and gifts they have. It should come as peaceful and comforting news to realize someone is just as responsible for their green eyes or tall height as they are for their special abilities. If no one is responsible for how they were made, people can be confident in God that he made them that way for a reason. A.W. Tozer suggests artists to hand their talents and gifts over to God and realize that talents and gifts are simply on loan to them. The Bible professes that God put us each together in a unique way. He fashioned us in a certain way to be where we are, doing what we are doing. He wired us to be drawn to certain things. He wired us each for a specific purpose.

To trust, to be truly whole, is also to let go whatever we may consider our qualifications. There's a paradox here, and a trap for the lazy. I do not need to be "qualified" to play a Bach fugue on the piano (and playing a Bach fugue is for me an exercise in wholeness). But I cannot play that Bach fugue at all if I do not play the piano daily, if I do not practice my finger exercises. There are equivalents of finger exercises in the writing of books, the painting of portraits, the composing of a song. We do not need to be qualified; the gift is free; and yet we have to pay for it.

Great art comes with a price. One of the reasons so much mediocre “Christian Art” exists is people mistakenly believe that God will magically provide them with talent in such a way that they will not have to study or work hard to create good art. Being a successful artist is

19 “For who sees anything different in you? What do you have that you did not receive? If then you received it, why do you boast as if you did not receive it?” 1 Corinthians 4:7 (ESV)


21 Psalm 139; “For you formed my inward parts; you knitted me together in my mother’s womb. I praise you, for I am fearfully and wonderfully made. Wonderful are your works; my soul knows it very well. My frame was not hidden from you, when I was being made in secret, intricately woven in the depths of the earth. Your eyes saw my unformed substance; in your book were written, every one of them, the days that were formed for me, when as yet there was none of them.” Psalm 139:13-16 (ESV)

22 L'Engle, 76.
painstakingly difficult and requires discipline, research, a great deal of education, apprenticeship, hard work, and all of one’s heart. Seerveld challenges artists to “Conceive art as work and undergo its training like a trade.” Bridges and food are not made by “good intentions and prayerful dedication”; if they are not approached with intelligence, specific education, and a sacrifice, one will fall through or dislike the blandness of taste.

If we want to see art that challenges the prevailing secularism we need artists who are not only skillful but also theologically well equipped, grounded in a fellowship and living obedient lives. Christianity is not a mere philosophy, it is a spiritual relationship that results in changed thoughts and actions, and it will only rub off on our work if it has first of all permeated our lives.

Being active in an artist community is also important because it is there that artists are able to see others’ view of God. A glimpse of the bigger picture and inspiration to search and discover more perspectives to include in one’s creations is a product of working and living among others. C.S. Lewis shines light on this fact, that we “…experience more of the wonder of God’s world as we [encounter art] and so enter into someone else’s perspective of this world.”

The amount of the artist’s talent is not what it is about. Jean Rhys said to an interviewer in the *Paris Review*, “Listen to me. All of writing is a huge lake. There are great rivers that feed the lake, like Tolstoy and Dostoyevsky. And there are mere trickles, like Jean Rhys. All that matters is feeding the lake. I don’t matter. The lake matters. You must keep feeding the lake…there is no trickle too small.

---

23 “Whatever you do, work at it with all your heart, as working for the Lord, not for men...” Colossians 3:23 (NIV) “...knowing that from the Lord you will receive the inheritance as your reward. You are serving the Lord Christ.” Colossians 3:24 (ESV)


25 Turner, 127-128.


The subject matter of *relent* was chosen after deciding upon the genre and overall desired audience impact. Once the extramusical content of the gospel message was chosen, I considered how it might be possible to best communicate my faith through the music of *relent*. It was my desire to create a compelling work of interactive electronic and acoustic art in addition to my interests in generative processes, indeterminacy, and improvisation that shaped the work into its resultant experimental structure.
In order to advance the world of interactive music, it is vital to be aware of the possibilities of computer interaction and what others have accomplished in the field. One of the specific goals sought during the composition process of *relent* was to build interactive possibilities that went beyond simple, typical immediately reactive relationships easily met in electronic music. While the Max patch of *relent* has a foundation of simply routing a live instrument input through an effect, e.g., a reverb unit, and directly out the speakers, a considerable amount of thought went into constructing the piece in such a way that it could breathe and present different modes of interaction.

Joshua Noble describes a number of different modes of interaction in his book, *Programming Interactivity*. Turning the page of a book or browsing a static webpage are not examples of interactivity. When the user is allowed to interact with a system in a number of different ways and the system must respond accordingly, reactive interaction occurs. A system that is constantly in motion, watched and adjusted by the user, is a regulatory system. A much more complex system of interaction is one in which either the user or the system learns based on the input or output transmitted. The last, and most complex system of interaction takes the form of a conversation. In this interaction, both the user and the system change their responses and motion or activity based on how the other acts and reacts over time.  

The system Cort Lippe built into the electronic part of *Music for Hi Hat and Computer* ...

---

contains aspects of a number of the interactive systems discussed above.\textsuperscript{29} A regulatory system is at work during much of the piece: it listens and changes its actions based on data such as pitch, amplitude, density, silence, and timbral qualities picked up from the hi-hat. Rather than simply implementing score following and effect changes, the Max patch records sections of the score as it is performed and plays it back using frequency domain FFT-based cross synthesis. The work is very dynamic; the performer is not controlled by the computer, but rather is in control of timing and free to use rubato.\textsuperscript{30}

The use of delays, layering, and granular processing is exploited in Timothy Place’s \textit{Dandelions}, a work for alto saxophone and interactive electronics.\textsuperscript{31} Much of the saxophone performance is manipulated by the computer and added to existing layers, creating an atmospheric effect. This creates an interactive system that is more complex than a simple reactionary system.

Unlike Lippe and Place’s strategies of both placing effects on and recording live acoustic instruments, Manoury uses a specially designed hardware device in his \textit{Partita I}, for solo viola and live electronic effects. This device measures acceleration and pressure of a viola bow. The data Manoury collects from the sensor device regulates the playback of synthesized string sounds with real-time data. Manoury’s reason for creating such an interactive, score following system was more about “enabling an accurate and flexible synchronization between the playing of the soloist and what is coming out of the loudspeakers” than it was about building flexibility into the

\textsuperscript{29}Cort Lippe, “Music for Hi Hat and Computer” (self published, 1998).


\textsuperscript{31}Timothy Place, “Dandelions” (self published, 2002).
Paul Wilson’s *Beneath the Surface*, for clarinet, flute, and computer, is an extremely quiet piece exploring the many sonic possibilities and development of the very limited content of only whispers and clicks from the acoustic instruments. Wilson uses a combination of the many interactive systems highlighted above. In order to go beyond a simple one-to-one relationship, Wilson uses delays, live recording, and granular processing. He also requires a technician to follow the score and trigger sound file playback with the computer keyboard.\(^{33}\)

Concert music composers can examine interactive installation art as a source for especially compelling interactive systems and tools. rAndom International conceived a project called *Audience* which is made up of about 64 football sized robot objects that simply look like personified small hand mirrors.\(^{34}\) Each of the objects is programed to move in a human-like way. Some seem to talk to each other, while others are more introverted. When people walk up to the installation, the mirrors choose one person to look at and follow. When they get bored, they go to someone else or talk with each other. The installation explores the reversal of roles by having the art look at the viewer. *Audience*’s technology could be very inspiring to a concert music composer. Treating instrument groups like swarms or autonomous sound producers effected by those around them could produce new sonic possibilities. Including indeterminate and improvisatory factors dependent on an outside force, such as a conductor or a solo instrument, could add to the human and organic characteristics of a work’s performance.

---


Brian Knep has created an entire series of works called *Healing*. *Healing* 1 appears to be an organic substance on the floor.\(^{35}\) When someone walks across the surface, the organic substance pulls away from where the person walked, appearing to be wounded. The organic substance then begins to heal itself, growing back differently than it originally looked, like a scar. The installation never looks the same as it is constantly being repaired based on past scars. The project explores interactions that, when executed, forever change future outcomes, something that could have extremely interesting effects on music. A piece, for example, could be created that presents a notated musical foundation, referred to as X, and directions for how to proceed with improvisation beyond the provided notation. After a section of improvisation, performers may then be instructed to return to a texture very much like X, but including aspects of the improvisation just executed. The piece could go on for many cycles of improvisation, X becoming X’, which becomes X’’, which becomes X’’’, etc. Eventually X evolves into completely new material.

Before composing *relent* or developing the electronic hardware and interactive software, a number of mandatory key features, based on interactive systems such as those just discussed, were established. Among these key features, simplicity and ingenuity of software design was of supreme importance. The performers’ ease in using the technology in practicing and performing the work, without the need for an outside technical assistant to run cues, was paramount to the design of the piece as a whole. Figure 1 shows what performers see. Preset numbers (seen as large zeros in Figure 1) are displayed large enough for performer feedback. Performers need only turn on the audio, set their microphone levels, click on the movement they are playing, and step

through presets using the pedals. Hardware used to perform the work needed to be easy to use as well as simple to make and/or cost-effective to purchase. Also, the interactive software developed for the piece needed to be stable, with as little chance of error as possible, and able to run at an especially low CPU load so it could be run on laptops of 2-4 years of age.

Figure 1. The performance mode of the Max patch used for *relent*.

The chosen instrumentation for *relent* is alto saxophone, double bass, and percussion I (b-flat crotale, water, marimba, suspended cymbal, bells with clappers, chain, and soccer linesman flags) and percussion II (toms, bongos, hi-hat, earth [dirt], drum filled with broken shells, ocean drum, chain, and bullroarer). This instrumentation provides a wide range of possible sounds, gestures, and instrumental combinations. Additionally, the pitch range from the lowest note on the double bass to the highest practical note on the alto saxophone is over five octaves and contains significant areas of overlap. The work also explores the choreographic and spatial possibilities between the two percussionists are also very appealing, as are the pairing possibilities between the four instrumentalists.

The technology setup for *relent* is relatively simple. Each of the four instruments use one
microphone and two foot pedals. One pedal is used to step through presets and the other pedal is used to provide functional control within the chosen preset. As a precaution, a recovery system is built into the patch in the event that a preset is advanced to prematurely.

Due to the large quantity of pedals required for and the high cost of USB pedals (often over $50 a piece), a custom pedal setup was constructed for the piece. The pedal setup can be built by anyone comfortable with doing basic soldering. The project calls for one Arduino compatible microcontroller, eight cheap momentary foot pedals with 1/4 inch male plugs, a project box, eight 1/4 female headphone jacks, and eight 10KΩ resistors. Tom Igoe describes a microcontroller as “a small, inexpensive computer, usually used for sensing input from the real world and controlling devices based on that input ... and they can communicate with desktop computers fairly simply as well.”

The hardware part of the pedal setup is fairly simple. To wire up a momentary pedal, a pull-down resistor must be added between the sleeve of the 1/4 plug and the ground of the microcontroller and a direct connection needs to be made between the sleeve and the digital pin being read on the microcontroller (see the schematic in Figure 1). The tip of the 1/4 plug receives 5V DC from the microcontroller. If the pedal is depressed, a connection is made between the tip and the sleeve, sending 5V to the digital pin. The microcontroller will then read HIGH. If the pedal is not depressed, no voltage reaches the digital pin and the reading is LOW. As many pedals may be added as there are digital inputs on the microcontroller. While no analog inputs

---


are used for *relent* to get data from sensors such as expression pedals, it is included in Figure 2 as a reference for future projects.

Figure 2. Schematic for pedals.

Ali Momeni and Chris Coleman developed the Maxuino.org website that provides Max patches, a Maxuino max object, and instructions on how to setup communication between an Arduino compatible microcontroller and Max/MSP/Jitter (cycling74.com). Because the maxuino object is included part of the patch built for *relent*, performing the piece requires that an Arduino compatible microcontroller loaded with the StandardFirmata software be plugged into the USB port of a computer running the piece’s max patch. Instructions for how to load the software onto the microcontroller are provided on the Maxuino site and below:
Loading software onto an Arduino compatible microcontroller: 39
1. Depending on your board you might need to install a driver for the serial port. (see http://arduino.cc/en/Guide/HomePage
2. Connect USB cable to the Arduino compatible microcontroller and your computer
4. Select the board from Tools > Board
5. Select the serial connection from Tools > Serial Port
6. Open the Firmata program by going to File > Examples > Firmata > StandardFirmata
7. Upload StandardFirmata to the board by pressing the upload button or File > Upload
8. Close the program when uploading has completed

In addition to control input, each instrumentalist’s microphone feeds audio input into
Max/MSP/Jitter via an audio interface. Percussionists are expected to move the position of their
microphone depending upon the instrument they play. The output from the Max patch is stereo,
therefore only two speakers are necessary to perform the piece. Any high quality microphones
may be used and many saxophonists and double bassists prefer their own, personal, live setup.

The Max patch for *relent* was constructed in a modular fashion. This allows the patch to
be reworked for future projects and makes this piece quite unique relative to the other works
mentioned above. Rather than treat the computer as another performer or an accompanying
device that receives all inputs and uses them as a sum to manipulate and regulate a “computer
part,” the computer is used rather as an extension of each of the four acoustic instruments. The
Max patch is created in such a way that each of the four microphone inputs go to their own
section of the patch to work with independently of the other members of the ensemble. Still, each
module of the patch can easily be manipulated into working together or into being controlled by
each other. Not only does this allow for many different sonic possibilities (each instrument is
extended rather than accompanied by a computer), it also allows performers to be more dynamic

and flexible with their timing.

In order to achieve an environment in which each performer gets his own section of the patch to work within and can yet be controlled by an overall system, each instrument receives one of four identical instrument abstractions created with different arguments. Each abstraction has its own pattrstorage object to control presets and a large set of effect modules including pan, reverb, freeze and hold, harmonizer, vocoder, granulator, flange/delay, record and playback backwards, and various loopers. Due to the scope of the pattrstorage object, it can only control parameters within the instrument abstraction, thus no messages being sent over “send” and “receive” objects effect other instrument abstractions, even if they are the same name. Fortuitously, due to the need to give script names to all controls within each instrument abstraction for the use pattrstorage, it is simple to send messages from outside each instrument abstraction using the creation argument. This enables constant, even random, control of parameters independently of preset settings.

Each instrument abstraction has a simple audio input from the live acoustic instrument that gets routed to any of its many effects via send~ and receive~ objects. Each instrument abstraction can route its input to two different places, which can either be used to send the input to two different modules (parallel) or to create a wet/dry mix. It is also possible to send any signal to any module (creating chains) within the instrument abstraction. Another feature includes independent module volume control that can be faded in and out over any amount of time. This can also be controlled from outside the abstraction. This is a significant feature that adds to the musical and organic processes of the patch, making it breathe and appear more human. The poly~ object is used for most of the effect modules in order to “mute” modules,
stopping them from processing data and taxing the CPU when they are not being used.\textsuperscript{40}

In order to provide a flexible environment in which to compose that enables a wide variety of sonic possibilities, a number of common as well as custom effects were built. The pan2 abstraction found in the max examples, was used for its efficiency and quality of preserving constant power. Its sweeping time function allows for slow panning. The reverb module uses newrev, an abstraction created at CNMAT.\textsuperscript{41} While it is not the best sounding reverb, it is very efficient and simple. Figure 3 below shows the user interface for each of these modules. While the performer does not see these user interfaces, they take away friction, thus simplifying the compositional process.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{pan_reverb_interface.png}
\caption{The pan and reverb user interface modules in \textit{relent}'s patch.}
\end{figure}

The hold and freeze effect, triggered by depressing pedal, is accomplished by implementing Jean-Francois Charles’s work with spectral analysis using jitter matrices to store spectral data. The smoother setting crossfades between frozen audio. Gizmo~, a frequency-

\textsuperscript{40} Cycling\textregistered\, dropped development of the mute~ and pass~ objects with the upgrade from Max5 to Max6, so poly~ was suggested by the company as an alternative.

\textsuperscript{41} “newrev~,” Center for New Music & Audio Technologies, available at \url{http://cnmat.berkeley.edu/patch/2957} (accessed February 1, 2012).
domain pitch shifter for pfft~, is used in the harmonizer module. The polyphonic vocoder was built using pfft~ to vocode incoming signals with a saw wave. One of the most texturally compelling modules is that of the granulator. Rather than freeze and hold a single small window of sound, the granulator can freeze and create textures and harmonies. The granulator utilized in this project is disis_munger.\(^\text{42}\) Due to tapin~ and tapout~ objects, the flange module doubles as a delay module and is based on the MSP tutorial that is part of the standard distribution. See Figure 4 to view the hold and freeze, harmonizer, vocoder, granulator, and flange setting possibilities.

\[^{42}\text{Disis_munger can be downloaded from: http://ico.bukvic.net/Max/}\]
Figure 4. Hold and freeze, harmonizer, vocoder, and granulator, and flange modules.

A custom module called “recpb” begins to record a signal into a buffer when the performer depresses the second pedal. When the pedal is lifted, recording stops and the software immediately crops the buffer to the length of the recording and plays the buffer backwards using
Three other unique modules include the looper, loopsync, and loop5. Through the combination of the use of the poke~, index~, and count~ objects (as seen on the bottom left of Figure 6), looper records into a single buffer, loops it, and punches in at any point in the file to record more layers without erasing previously recorded material. The loopsync module is a modified version of the looper module that allows loops to sync up between the four instrument abstractions. Loop5 is a module that allows for five different sized loops that can all have layers indefinitely added on top of them. Figure 7 shows the user interface of these modules.
Figure 6. Looper abstraction.
Figure 7. User interface for looper modules.

In addition to the counterpoint created by the use of modules such as the looper and granulator, additional counterpoint is created through the many recordings made and stored in
buffers during the second movement of the piece that are recalled during the third and fourth movements.

With a number of different modes of interactivity, the patch for *relent* extends the acoustic instrumentalist’s sonic possibilities while allowing for flexibility and musicality. Its simple interface and setup make it accessible to those that even know nothing about technology, yet no compromises were made in doing so. The variety of modes of interactivity that the patch allows for also had a dramatic impact on the structures of the piece.
Chapter 4

Analysis of relent

General Overview

Each of the five movements of relent are entitled with a word beginning with “re-” to emphasize what I consider to be the most important aspect of the gospel message: relationship. Reformed theology builds a case that God finds great importance in relationships, that God gave his only son so that the relationship between man and God could be restored. The narrative created in the combined five movements of relent strives to emphasize this aspect of the gospel message. An analysis of each movement exhibits a correlation between this narrative and the musical structure. Though compromises had to be made by not including every literal aspect of the gospel message to better serve the musical structure, it is my hope that the essence of the message remains.

A wide variety of relationships are exhibited in the instrumentation of relent as shown in Table 1. Acoustic instruments interact with the computer in three out of the five movements, one of the movements is for acoustic instruments (though recordings are made during the movement by the computer for use in later movements), one of the movements calls for only the computer, and the score for one movement is generated in real-time by the computer. Additionally, two of the movements predominantly contain mostly consonant harmonies, one of the movements contains both consonant and dissonant harmonies, and two of the movements are primarily dissonant.
Table 1. An overview of the variety constructed into relent.

<table>
<thead>
<tr>
<th></th>
<th>movt. 1</th>
<th>movt. 2</th>
<th>movt. 3</th>
<th>movt. 4</th>
<th>movt. 5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“realized”</td>
<td>“rejected”</td>
<td>“redeemed”</td>
<td>“reconciled”</td>
<td>“reside”</td>
</tr>
<tr>
<td>acoustic instruments</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>and interactive</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>electronics</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>acoustic instruments</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>only</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>electronics only</td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>electronically</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>generated score</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>written out score</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>consonant harmonies</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>dissonant harmonies</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Movement I, “realized” (Creation)

The first movement, “realized,” is inspired by the creation story found in Genesis.\textsuperscript{43} The movement is made up of an introduction and two main sections, referred to as sections A and B. Rehearsal markings 1-7 also indicate the beginning of each of the days of the creation story. The introduction to the movement contains the first two days of creation using temporal notation. Section B, spanning from rehearsal marking 3 to rehearsal marking 7, is metered and contains a constant beat of quarter note equals 120bpm. The last section, section A, contains a mix of metered and non-metered notation.

\textsuperscript{43} Genesis 1-2; All things that were created were created through Jesus (John 1:1-5).
From a strictly musical standpoint, the purpose of this movement within the work is to provide extreme contrast with the middle movements. A feeling of peace, harmony, and rhythmic stability is provided in movement I that is broken with the abrupt interruption of the dissonant, violent, aggressive gestures of movement II. The continuous entrance of new instruments and motives as well as subtle, easing in of electronics makes the entire movement serve as an introduction to the rest of the work. The repetition of section A and pedal tone in section B give the listener a sense of added security which, when broken, adds to the violence intent of movement II. Further analysis, including programmatic context, will facilitate an understanding of the formal structure of movement I.

The piece begins with a literal representation of the breath of God with the percussionist blowing into the microphone and the creation of the earth with the percussionist striking low toms. Simultaneously, percussion 1 signifies the piercing presence of a massive light by bowing a crotale. Rather than attempt to perfectly represent all of what is interpreted to have occurred during the first day of creation, I chose instead to simply provide an opening gesture that thwarts curiosity and interest. The theatrical lighting in this movement is intended to highlight the creation narrative in a visceral and direct fashion. The moment percussion 1 begins playing the crotale, stage lights switch on; the moment the crotale stops and a hi-hat is struck, stage lights switch off.45

Rehearsal marking 2 represents the second day, the separation of water and dry land, illustrated with improvisation with water and dirt by the percussionists. Many argue as to

44 Psalm 33:6, 148:5, 29:3-9

45 Lighting cues are indicated above the score (see Figure 7 for an example of this).

46 Genesis 1:9-10
whether there was any dry land at all on the second day of creation. Because it does not challenge my faith or the validity of this work, I chose to use dry dirt and water for their sonic and theatrical potentials and effectiveness in the introduction of a movement about creation. As seen in Figure 8, both percussionists enjoy little constraint to guide their improvisation. The score merely provides start and stop times. A significant amount of the entire piece is built upon indeterminacy and improvisation, so it is significant that improvisation is present in the introduction both as a foreshadow and as a cohesion tool.

![Figure 8. Beginning of movement I, “realized,” of relentless.](image)

Section A begins with the entrance of the marimba at rehearsal marking 3 establishing a tempo of quarter note equals 120bpm that will last until section B. The marimba provides a rhythmic, four-chord harmonic ostinato upon which other voices are added throughout the section. The lower note of each of the four chords are the first four notes of an Eb dorian scale. As seen in Figure 9, the first and third chords are major triads and the second and fourth chords contain major thirds and perfect fourths (the perfect fifth used to harmonize the previous note). The ascending line functions to both give the perception of progress and development and
represent the new growth of plant life as seen in the creation narrative.

![Figure 9. Ascending marimba harmonies.](image)

Section A, systematically adds more counterpoint, thus evolving as creation did, from simple to complex. The double bass entrance at rehearsal marking 4 signifies the creation of the sun and stars. Its slow ascension mimics our perception of the movement of the sun. Percussion 2 enters at rehearsal marking 5 playing on the rim of a drum with drumsticks and whistling bird calls into the microphone. Through the use of constantly changing delay effects built into the flange module, the bird calls are perceived as swarms of birds and other animals created on the fifth day. To add more activity, percussion 1 begins improvising rhythms and accents on the marimba within the frame he was given previously.

At rehearsal mark 6, the saxophone enters to signify the creation of man by sounding the first especially melodic line. The monophonic line, through composed with no repeats to symbolize how man is different than the rest of creation, provides a point of interest and focus in the musical form of the movement. At the fifth measure of rehearsal marking 6, the saxophone line begins to be more simple, confined, and for the first time repetitious. That moment is intended to paint the scene of Adam being put to sleep by the Lord in order to form Eve out of his rib. Because the other instrumentalists are looping and improvising upon material presented earlier, the saxophonists has liberty to take as much time as is musically fitting. The line is

---

47 Genesis 1:14-19

48 Genesis 2:21
augmented with a harmonizer module, adding more counterpoint and thus creating a musical interest of development while also symbolizing the creation of woman.\textsuperscript{49} The moment is heightened by the double bass’s ascension to an F. Because the bass slowly ascends from Bb to Eb and keeps emphasizing the Eb by constantly alternating between Eb and Db, as seen in the reduction of Figure 10, the next logical note a listener expects to hear is F. While not a stable arrival point, the bass’s sounding of an F provides a sense of progress.

Figure 10. Double bass reduction from rehearsal mark 4 for nearly 7.

Section B, representing the sabbath (day of rest),\textsuperscript{50} has a completely different character from the rest of the movement, adding contrast and depth. The section begins with the establishment of a pedal tone B created by the double bass playing into a granulator and the marimba improvising on B in various registers throughout the section. Background percussive sounds are also improvised by percussion 2 and the sense of pulse dissipates. The double bass enters with metric material at an ad libitum tempo. The saxophone eventually enters in a call-response relationship with the double bass. This dialogue progresses into a non-metered, rhythmically free section where only note heads are provided. Lastly, the two instruments play together, creating 1:1 counterpoint on the melody heard at the beginning of day 7. Due to the development of the this dialogue during the beginning of section A, the 1:1 counterpoint is perceived as a dramatic arrival point. The duet develops as chromaticism and lengthened suspensions make it sound more and more passionate. It is then dramatically interrupted by the

\textsuperscript{49} Genesis 2:22

\textsuperscript{50} Genesis 2:1-3
start of the second movement, “rejected,” with the crash of a drum filled with sea shells hitting the floor.

The movement is fashioned to make the most sense aurally. In order to preserve a smooth, stressless flow of music, a compromise had to be made to leave out a number of aspects of the Biblical creation narrative, such as the conversation struck with Adam and Eve by Satan in the form of a snake. Also, movement II quickly and violently interrupts movement I for dramatic effect; a more literal translation of the Bible shows sin entering the world and slowly creeping its way into all forms of life.

Movement II: rejected (Fall of Man)

Movement II is named “rejected” and is intended to depict the fall of humanity from grace.\textsuperscript{51} A common interpretation is that man’s act of selfishness had a wealth of consequences\textsuperscript{52} and creation would no longer function as it was meant to function. To illustrate this theatrically and sonically, extended techniques are pervasive throughout the movement. Only the neck and mouthpiece of the saxophone may be played, the double bass must be lowered to the floor and be played on its side, cymbals and other instruments must be played on the floor without stands, and a dismantled drum filled with broken sea shells is also played on the floor.

The second movement begins with a visual representation of The Fall with a drum filled with shells falling to the floor, cymbals falling to the floor, and the double bassist slowly lowering the instrument to the floor while bowing. The entire movement is a succession of extended techniques with only several instances of polyphony. Proportional notation is used in the movement to create an even more naturally uneven, unmetered feel. Each performer is asked

\textsuperscript{51} Genesis 2:15-17

\textsuperscript{52} Genesis 3:14-19
to make each short gesture sound as immediately after one another as possible. Figure 11 is an excerpt of the score showing the use of dotted lines to assist performers in seeing the order of events while solid lines show when two events occur simultaneously.

Figure 11. Excerpt from the first page of movement II, “rejected.”

The movement is meant to be performed loudly and aggressively, but in order to create a more compelling musical form to the movement, the narrative is broken and a short, quiet section is presented at rehearsal marking 13. Tension is gradually built up prior to rehearsal marking 13 in such a way that one would expect a very loud peak where the quiet section is located. All four instruments alternate gestures between each other in no organized manner from the beginning of the piece to rehearsal marking 12. At that point, nine events are exchanged between saxophone and percussion 2 only. Then, double bass and percussion 1 enter and all four instruments sound simultaneously for the first time in the movement. To heighten the moment
even more, unique instruments, such as a bullroarer, soccer linesman flags, simultaneous double bass extended technique (pizz., hammer on / pull off, bowing, percussive use of a bass drum mallet on the body of the instrument), and an aluminum foil tube for the saxophone neck and mouthpiece sound all at once. The quiet section begins with an unexpected cut off by linesman flags and a quiet improvisation on the drum filled with shells. The section is very short lived, interrupted at rehearsal 14 by the violent slamming of a chain and more loudly aggressive gestures similar to the beginning. Like the previous movement, there is no break between movements II and III, instead the two movements overlap in a dovetail fashion.

No apparent electronic interactive element exists in movement II. Instead, the computer intelligently records each short gesture that is sounded and stores those gestures into separate buffers to be used during movements III and IV as symbols of evil and sin. Figure 12 is the abstraction that records each gesture by measuring volume level. If the volume level is above a certain threshold, the computer records the input, if it is below the threshold for a set amount of time, 1500 milliseconds, it stops recording, cuts off the last 1500 milliseconds and moves on to recording in the next buffer. By not using any computer effects and by not requiring the use of pedals in recording, movement II stands as a symbol that mankind (represented by the live performers) was wholly responsible for its sinful acts.
Figure 12. The abstraction that records each gesture in movement II.
Movement III: “redeemed” (Redemption)

According to the Bible, the relationship between God and man, wrecked by The Fall of Man, was saved when Jesus died for man’s sin, took man’s sin from him, and put it on himself (atonement) to fulfill God’s wrath. Movement III of relent seeks to symbolize this atonement through the exploration of slow transformation, an intrigue of numerous composers. Many pieces of art exploit processes, making actions and system of change central to the overall experience. For example, Steve Reich’s Drumming makes use of the process of unison rhythms played between a group of musicians becoming more complex over time as one performer slowly changes tempo. Similarly, Jonathan Schipper’s Measuring Angst centers on the process of destruction by way of robotic arms continuously and slowly recreating the breaking of a glass bottle against a wall in 12-minute cycles. The computer in the third movement of relent generates a slow sonic transformation over the course of the movement through the use of multiple granulators, biquad filters, reverberation, panners, an automated x/y coordinate generator, and some playback objects (groove~).

In order to illustrate the process of atonement, two completely different textures are slowly manipulated. Multiple samples, recorded from the second movement, stored in buffers, and catalogued in a coll object are played through a granulator to create a cacophony of dissonant sound. The texture remains the same until another sound, built out of the same samples but granulized into consonant harmonies, seems to sweep by. In order to make the second sound sweep by, a metronome, set to change duration randomly, triggers objects that output random

53 Romans 1-3, 1 Corinthians 15
numbers. Those random numbers are sent to two line objects that give out x/y coordinates, creating the path of the moving second sound. The metronome also bangs a counter every time a sweep is made. The counter’s output is sent through various scalers to control the settings of the granulators for each of the two sounds. Each sweep brings the first sound closer to becoming the second sound and the second sound closer to become the first sound. The effect is that the first sound, which constantly plays, has the aural perception of transforming into the second sound and vice versa. Like Schipper’s *Measuring Angst*, interest in movement III lies in the slow process of change, that which occurs during the process of change.

Movement IV: reconciled (Justification/Sanctification)

The acoustic performers return to the scene in movement IV. This movement represents the restoration of the relationship between God and man through God’s saving grace. Performers are given no score for the movement to signify the sovereignty of God and his active, guiding presence. Instead, the computer generates and displays what the performers are to play based on algorithms with built in randomness. The movement is an experiment in generative composition within the genre of interactive electronics. The randomness built into the movement both ties it to the third movement and produces a unique relationship between the acoustic instrumentalists, forcing them to listen and create links between each new instruction and each other.

Because the computer generates a different score for every performance, the musicians are forced to rely on the computer rather than their own practice and security. The process the computer goes through over the course of the movement is based on one of a few different possibilities.

---

56 Ephesians 2:4-9, Colossians 2:13-15
possible trajectories randomly selected when the movement begins, and a number of different possible choices randomly selected during the course of the movement. Pitches are chosen from probability tables, presets are chosen from coll objects, and durations for each action are randomized, but increased over time. The screen of the computer is divided into four parts so that each performer gets his own portion of the screen (saxophone = top left, double bass = top right, percussion 1 = bottom left, and percussion 2 = bottom right). Jitter is used to display all information performers need, as seen in the example of Figure 13. When a preset, pitch, and action is chosen by the computer, it is displayed in the respective performer’s box. Behind the scene, the computer changes the pattr preset for that particular performer’s instrument module. See Figure 14 for a look at one of the abstractions used to choose and display text for one of the four squares displayed.

Figure 13. Computer generated score for movement IV of relentless.
Performers have only one way to communicate with the computer: if they desire to move
on to the next action, they may press the pedal once and if they desire to stay on a preset, they hold the pedal down. Performers’ use of the pedal can be overridden by the computer if the computer is executing a process.

As the performers play, the computer also plays back recordings made during the second movement to symbolize how sin continues to be a struggle throughout life. Performers are encouraged to occasionally look away from the computer screen in a theatrically, obvious way and mimic what they hear in the recordings, thus averting their eyes from God and straying from the path he is guiding them down.

Movement V: reside (Reconciliation)

Like movement III, movement V’s focus is fundamentally on processes and interpolation. Movement V is entitled “reside” because the movement’s inspiration is that of one spending eternity in Heaven. To illustrate eternity, movement V has very little dynamic contrast and no sudden changes as if to freeze the listener in suspension. A key visual aspect of the movement is that performers turn to face the same direction as the audience in order to represent a unified glorification of God in Heaven.

Each movement of relent utilizes different composition strategies. The first and last movements are similar harmonically, as the New Heaven and New Earth are prophesied to be similar to the original creation. While the first movement establishes a rhythmic foundation with an eighth note ostinato played by the marimba and a strict time signature, the last movement flows freely without any rhythmic center or metered music. Each of the first four pages of the fifth movement establishes one of the four chords heard in the first movement. So, the harmonic material for movement V is very simple, but the unique and interesting aspect of the movement
is the cross-fade between chords. Each performance of the movement will sound differently because timing is very flexible and the movement takes on an organic, slowly transforming character. Performers are required to proceed in order as indicated on the page and play their independent actions in sequence with the others. Figure 15 assists in understanding this concept. It is between pages that the chord built by each page is finally realized and heard without any foreign material.

Figure 15. Simplified model of an excerpt from movement V.

The textural characteristics of movement V are that of long-breathed, extended, sustained gestures. Pitches and textures are stretched out infinitely through the use of granular synthesis and phase vocoder techniques. Rhythm and isolated events are blurred by looping layers of buffers of differing lengths. In order to symbolize abundant glory, of never growing weary of learning new things about God, each page includes new sounds not heard during the first four movements of the work. To multiply the effectiveness of this, even the new sounds are given electronic processes not yet heard over the course of the work. Once again, for ease and accessibility, performers need only step through presets and play what is notated.

The piece concludes with the foundation of a B pedal tone vocoded to create a B major chord with added major second and sixth. Once that foundation is solidified, the sabbath theme,
as heard in the first movement, is brought back by the saxophone and double bass. A gradual
decrescendo to nothing brings the piece to its conclusion.

This analysis showcases the emphasis on relationships and the parallels between the
biblical gospel narrative and the musical structures found in relent. Including interactive
electronics into the work inspired new forms of relationships. Whether a listener withholds an
understanding of the gospel message and its significance in the inspiration of this work is
irrelevant. The musical structures of the piece and the interactivity found between electronics and
acoustic instruments make the piece an aurally captivating and thought provoking work.
Chapter 5

Conclusion

There are many different ways to go about composing an interactive electronic piece. I am happy to have created everything modularly. In the future, I will be able to take abstractions from relent’s computer part and use them in patches for other pieces. I can see a world of advantages in drafting out the entire notation of the piece before creating interactive electronics. For relent, my first interactive work for an ensemble, creating the electronic part first was advantageous because I needed to experiment to discover the interactive possibilities during the compositional process. In the process of developing electronics for the piece, I also created additional electronics that, though not used in this piece, will be used in future projects.

relent has provided a significant step forward in developing and solidifying creating works for ensemble and electronics, a path few composers have worked in. Composition of the piece highlights the need for efficient, cheap controllers as interactive works for chamber ensemble continue to be developed. I plan to work on designing more devices that others can easily build and use on their own, like the Arduino and pedal combination used in relent. Using controllers can lower the amount of stress and time programming a patch. The patch can obviously be less intelligent when more human controlled, but the most significant advantage is in allowing the patch to breathe. When performers control the patch they are not controlled by the patch; they choose (more or less) when events will occur and when more time should be given to something “in the moment.”

The research I completed on art and Christianity was fruitful and points toward paths of exploration and scholarly research to benefit others. My hope is that my research will help in my
teaching, composing, and viewing art. Due to this dissertation, I have discovered a passion that will fuel the writing of books, creating a website, and/or seminars on the subject. I hope others benefit from what I have compiled.

One product that results from my work on *relent*, my first work to use programmatic ideas, is my understanding that Christian artists are not required to create art with blatantly Christian topics. In the future, I can imagine choosing topics of less breadth and depth and, ironically, with fewer limitations. The gospel, the core of the Christian faith, is a programmatic idea of great undertaking. Because the gospel message has so many important parts to it, creating a piece that fully displays every aspect of it is daunting and impossible. There are so many individual literal details to present when illustrating the gospel in a form of art. One must compromise and either loose the overall essence of the gospel by getting buried in details and providing the audience with too much complexity, or remove details to serve the overall essence of the grand idea.

So, I feel that in choosing to create a work of programmatic art, one may have to choose to be a slave to one medium (e.g., story) that may not easily be carried over into another medium (e.g., music). Compromises were made in creating *relent* that made the work of art a more effective piece of music without removing the essence of the gospel message. Moving forward, I am interested in creating more abstract works that exude my Christian faith through their creativity and form rather than through their topical content. In future works, I will integrate my experience with *relent* through a deeper exploration of the abstract formal properties of musical structure and form, improvisation and generative music, and interactive electronics.
Reference List


PART II

relent
relent

alto saxophone
double bass
percussion
interactive computer

by ben johansen
Instrumentation
- alto saxophone
- aluminum foil
- double bass
- bass drum mallet
- percussion 1
  - B-flat crotales
  - water
  - marimba
  - suspended cymbal (16", 18", 20")
  - bells with clappers
  - chain
  - soccer linesman flags
- percussion 2
  - 4 different low toms
  - 2 high toms
  - bongos
  - earth (dirt)
  - drum filled with broken shells
  - ocean drum
  - chain
  - bullroarer

Technology Requirements
- four microphones
- eight foot pedals
- audio interface with four mic inputs and two audio outputs
- computer running Max6 or Max6 Runtime software (cycling74.com)
- two large studio quality speakers

Interactive Computer Instructions
1. copy the entire folder of relent patches to the computer
2. connect pedal setup to the computer (construction instructions are available on the next page)
3. connect audio interface to the computer
4. open Max6 or Max6 Runtime
5. open_main-patch.max (found inside the relent patches folder)

Once the patch is opened, do the following (each is labeled in the diagram to the right):
1. turn on audio processing
2. set levels for all four microphones (levels should be set on the interface and "unity" should be used in this patch)
3. set level of output (levels should be set on the interface and speakers; "unity" should be used in this patch)
4. click on "1, realized" button
5. perform the piece by stepping through presets as seen in the score; feedback for what preset is being used will be shown on the screen
6. to advance to the next movement, click on its name within the patch
Pedal Setup

The pedal setup can be built by anyone comfortable with doing basic soldering. The project calls for the following:

- (1) Arduino compatible microcontroller (Teensy 2.0 is seen in the figure below)
- (8) momentary foot pedals with 1/4 inch male plugs
- (8) 1/4 female headphone jacks
- (6) 10KΩ resistors
- (1) project box (optional)

The hardware construction of the pedal setup is fairly simple. To wire up a momentary pedal, a pull-down resistor must be added between the sleeve of the 1/4 plug and the ground of the microcontroller. A direct connection needs to be made between the sleeve and the digital pin being read on the microcontroller (see the schematic below). The tip of the 1/4 plug receives 5V DC from the microcontroller.

Because the Maximo object is included as part of the patch built for real-time, performing the piece requires only that an Arduino compatible microcontroller loaded with the StandardFirmata software be plugged into the USB port of a computer running the piece’s Max patch. Instructions (found on the Maximo.org website) for how to load the software onto the microcontroller are provided below:

Loading software onto an Arduino compatible microcontroller:
1. Depending on your board you might need to install a driver for the serial port.
   (see http://arduino.cc/en/Guide/HomePage
2. Connect USB cable to the Arduino compatible microcontroller and your computer
4. Select the board from Tools > Board
5. Select the serial connection from Tools > Serial Port
6. Open the Firmata program by going to File > Examples > Firmata > StandardFirmata
7. Upload StandardFirmata to the board by pressing the upload button or File > Upload
8. Close the program when uploading has completed

Pedal Use in Performance

Each performer is given two pedals (SAX=1 & 2, DB=3 & 4, P1=5 & 6, P2=7 & 8). In the score, numbers in circles indicate the use of the first pedal (1, 3, 5, 7) to change presets and pedal markings (1, 2, 3, 4, 5, 6, 7, 8) indicate using the second pedal (2, 4, 6, 8) to work within each preset.
1. realized

* stage light operated by stage manager

od. lb. water

od. lb. earth (air)

peat until new material is given

od. lb. rhythms (rests, accents, not durations, etc.), but keep voicing and chord change location unchanged

Ben Johansen
2. rejected

SAX

make tube extension with hand, voice to get overtone and slowly slide pitch around

pitchless squawk: start note but immediately open mouth

no vib.

mouthpiece

circular bowing

slowly lower DB with E string up

(DB remains on side for the entire movt.)

18" cymbal

felt mallet cymbal

16" cymbal

drumstick handle

2 sticks

L.V.

L.V.

prepared tom

push drum off stand onto floor

violently shake/shave drum shell filled with shells

hit head of drum with drumstick
3. redeemed

computer only
4. reconciled

computer generated score
5. reconciled

SAX  peaceful, non-aggressive

70  peaceful, non-aggressive

D  sul tasto  sul pont.

P1  peaceful, non-aggressive

P2  peaceful, non-aggressive
71. Using the effects pedal, record different lengths of the note below.

SAX

DB

Use effects pedal to record the five loops provided; ad. lib. dynamics and length of each loop.

73

72. Ad. lib. various bells with clappers.

74 - 75 - 76 - 77 - 78 - 79 - 80

P2

Ad. lib. low, mellow drums gently

Use the effects pedal to record a phrase; upon lifting the pedal the phrase will play back backwards.
4'30" | 71

**SAX**

- 4" note, repeat 5x
- 4-5" note

**DB**

- Overdub current loops

**P1**

- Ad. lib. cymbal

**P2**

- Ad. lib. high pitched drums

---

Using the effects pedal, record different lengths of the note below.
SAX

P1	ad. lib. various bells with clappers and B's on the marimba

DB

P2	ad. lib. ocean drum